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Golden Apple Scholars of Illinois (GA) Program

Application, Certification and Award Determination

Applications for the Golden Apple Scholars of Illinois Program are accepted and processed by 

the Golden Apple Foundation, and the program is administered in GAP Access in partnership 

with the Foundation and the participating colleges that Scholars are attending. 

Once the Foundation has evaluated applicants and determined who may be eligible to receive 

benefits of the GA program, the Foundation provides applicant data to ISAC which is uploaded 

to GAP Access. 

The Foundation then completes the certification process in GAP Access and identifies which 

applicants are currently meeting eligibility criteria for the program. Colleges do not need to 

complete the certification process for GA, as is done for the Minority Teachers of Illinois (MTI) 

Scholarship Program. 

For applicants certified as not eligible by the Foundation in GAP Access, one of these 

indicators will be provided:

– Probation

– Exits

– Not Reporting.

As the Foundation completes the certification process, program awarding is automatically 

determined based on grade level, applicant category, etc., and the Foundation has the ability to

override and adjust an award amount in GAP Access, as needed. Any changes to certification 

data after awarding has taken place are made by the Foundation or ISAC.

After the certification and awarding process has been completed, payment functionality will be 

made available in GAP Access so that colleges can complete the payment request process for 

awarded students who are enrolled and continuing to meet eligibility requirements at their 

institution.  

The total number of scholarships awarded each year is contingent upon the funds appropriated 

by the Illinois General Assembly, and the awarding process does not occur until after a final 

appropriation has been approved by the General Assembly and the Governor.
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ISAC Identification Number

If a student has not applied for the Monetary Award Program (MAP) and when an applicant 

begins the process of completing an application for the GA Application a unique ISAC 

identification number will be assigned to the student applicant. 

For applicants who submit an Alternative Application and submit the GA application 

simultaneously they will be assigned the same unique ISAC identification number. 

If the student has applied for MAP and has an ISAC unique ID number, they should use it when 

applying for the GA Program.  

This unique ISAC identification number is a permanent identifier that will remain the same for a 

student every year.

Payment Processing

Colleges submit payment requests using the GA system in ISAC’s GAP Access portal throughout 

the course of the award year.  Payment is made to colleges through an offset process. As part of 

this process, new payment requests are compared to outstanding amounts owed to ISAC, and 

payment is made accordingly

Golden Apple Scholars of Illinois (GA) Program



Access and Navigation

The system to administer the Golden Apple Scholars of Illinois (GA) Program is available through 

ISAC’s Gift Assistance Programs (GAP) Access portal at https://isacportal.isac.org. 

All users need a valid GAP Access ID and password to access the system. 

ISAC relies on a designated Primary Administrator (usually, the Financial Aid Director) at each 

institution to authorize users and provide them 

with the appropriate level of access for each

ISAC program.

Once a school user has successfully logged in to 

GAP Access, the GA information can be accessed

by selecting the GA program from the Program list.

Please note that the GAP Access system will time out after prolonged inactivity. 
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GA Student List Eligibility: View

Once you have navigated to the GA Program in GAP Access, you can view the list of applicants 

provided by the Golden Apple Foundation who may be eligible to receive benefits of the GA 

program. The list will initially appear in alphabetical order, however, you may use the Filter, Sort 

and Columns functionality to customize your view as needed. 

In addition to the applicant data, the Student List Eligibility: View screen includes the application 

date, applicant category, certified status, certification date, and award amount.  An indicator is also 

provided if the applicant has been awarded the Minority Teachers of Illinois (MTI) Scholarship 

Program. ( A student cannot receive benefits from both programs in the same academic year.)

Applicants with eligibility or conflict issues will be identified by icons in the List view, and more 

information can be obtained on the applicant’s Student Detail screen by selecting the magnifying 

icon           in the first column of the student record.

A yellow lightbulb       is an indicator of student eligibility issues, and a red triangle        is an 

indicator of a conflict issue. 
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GA Student List Eligibility: View
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Initial default view:

View when scrolled to the far right, which includes the award amount column:



GA Student List Eligibility: View

Depending on your computer, monitor, and screen settings, you may need to use the horizontal 

scroll bar at the bottom of the page to navigate farther to the right to see these columns on the 

Student List Eligibility: View screen. 
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One of the following indicators 

will be provided for students who 

have been certified by the 

Foundation as not eligible: 

• Probation

• Exits

• Not Reporting

The award amount will be automatically 

populated once the Foundation certifies 

the student as eligible, and the 

Foundation has the ability to override 

and change the award amount, as 

needed.



GA Student Eligibility List: Filter Screen

You may filter student records by selecting specific categories provided on the Student Eligibility 

List: Filter screen, which can be accessed by selecting the Filter tab. 

9

Once you have selected your criteria from the drop down menus and/or selected the category 

options on the right side of the screen, select the List tab (located to the left of the Filter tab) to 

generate your customized view.  

A Reset tab is also available to clear multiple selections with one click. 

April 2021



GA Student Eligibility List: Sort Screen

The Student Eligibility List: Sort screen provides you with several options for sorting the student list. 

This screen is accessed by selecting the Sort tab.  

To sort your list, check the box next to the the data element(s) you would like to sort by, then select the 

Add arrow to add them to the Selected list. 

Use the Move Up arrow to put the data elements in the order in which would like the list to be sorted.  

You can also drag and drop your selection(s) into the Selected or Unselected column.
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Selected checkboxes will be sorted descending. Unchecked checkboxes will be sorted ascending. 

Once you’ve made all of sorting selections, click on the List tab (located to the left of the Filter tab) 

to generate your customized list.  

A Reset tab is available to clear multiple selections with one click. 
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GA Student Eligibility List: Columns Screen

The Student Eligibility List: Columns screen allows you to select the columns you want to view 

and customize the order in which they appear. This screen is accessed by selecting the Columns 

tab.  

To select a Column for your customized list, click on the column heading to highlight it and then 

the Add arrow to add it to the Selected list. 

Similarly, to remove a column from the List view, select the Column heading in the Selected list 

and then click on the Remove arrow to add it to the Unselected list. 

Use the Move Up and Move Down arrows to put the columns in the order in which would like 

them to appear on the List screen.

You can also drag and drop your selection(s) into the Selected or Unselected column.
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Once you’ve made all of selections, click on the List tab (located to the left of the Filter tab) to 

generate your customized list.  A Reset tab is also available to clear multiple selections with one 

click. 
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GA Student Detail Eligibility Screen
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The Student Detail: Eligibility screen displays information from the student's application as well as 

certification and eligibility information for the GA program. The purpose of this screen is to allow 

users the ability to view eligibility details for an individual student record. The Student Detail: 

Eligibility screen is accessed by clicking on the magnifying glass icon           in the first column of the 

student record on the Student List Eligibility: View screen.

To select another student's Detail screen, enter a new Social Security Number in the Current SSN field 

and click on the Go button. 

These data elements indicate if an applicant is 

a Deferred Scholar or a Pathways Scholar. 

• Deferred Scholar is one who was not 

inducted as a Golden Apple Scholars of 

Illinois Program incoming freshman. The 

scholar, providing he/she maintains 

eligibility and is inducted, may receive the 

deferred freshman award amount, in 

addition to his/her sophomore award 

amount.

• Pathway Scholar is one who enters the 

program as either a sophomore or junior in 

college. These scholars are entitled to either 

two or three years of benefit,  accordingly.



GA Payment Processing 

GA payment processing is done using the GA system available through ISAC’s Gift Assistance 

Programs (GAP) Access portal.

GA payment processing can be accessed by selecting GA under the Programs tab near the top of 

the screen. Program functions are contingent upon each user program privileges. The administrator 

must access the User Maintenance area and update the program access and level for each user. 

– “None” will grant you zero access to GA data. 

– “Update” will grant you the ability to both edit and view GA data. 

– “View” will grant you the ability to only view GA data (i.e., no editing ability

After completing the payment request process in GAP Access, payment is made to colleges through 

an offset process. As part of this process, new payment requests are compared to outstanding 

amounts owed to ISAC, and payment is made accordingly. This system was developed to 

accommodate the many changes in student eligibility that can occur during the awarding and 

disbursement of financial aid (including decreases, increases to awards, initial requests, and full 

refunds). Therefore, funds should be returned to ISAC only after a final reconciliation has been 

completed at the end of the regular school year. All schools with an outstanding amount owed to 

ISAC at the end of the school year receive a notice indicating the total amount to be returned.  

Information about the payment offset process and reconciliation is located on the Refunds and 

Unpaid Claims page in the Processes area of the FAA section at isac.org.
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Student Payment List: View Screen 

The Student Payment List: View screen gives the user the ability to easily select students to view 

payment-related items such as payment request amounts, payment result amounts, and payment result 

codes at a glance. It operates like the Student List Eligibility: View screen, allowing the user to select 

students who are attending their school and to filter and sort the list according to specific criteria.  

The initial loading of this page will result in a default view with the following columns: 
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• Sel (Select) 

• Req Sel (Req Select) 

• Term 

• Current SSN 

• Last Name 

• First Name 

• Annual Award 

• Requested Amount 

• Term Award

• School Code

• Request Code *

• Enrollment Status *

• Ineligible Reason *

• Amount Paid

• Adjusted Amount

• Result Code*

• Expanded Result

• Result Date

• Status Code *

• Invoice Number

• Awarded GA 

* All codes can be found at the end of the user guide. 

Schools can create a customized Student List Payment: View screen by selecting specific 

columns to be viewed, as well as use data sorting and filtering. 

The Student Payment List: View is accessed by selecting the Payment tab. The following 

functions are available on the Student List Payment: View screen: View, Filter, Sort, 

Columns , Payment Request Entry and Submit Payment Requests.



Student Payment List: View Screen 

Check the boxes in the Req Sel column to select students for payment. Save your selections by 

clicking on the Save Selected button at the bottom of the page.
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Payment Eligibility List: Filter Screen
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The Filter screen provides many different options for filtering the Student List Payment: View 

screen.  Users can change the records to be viewed on the Student List Payment: View screen 

by setting specific criteria for one or more of the options on the Filter screen. 

For the Ineligible options, if more than one is checked a record must meet all conditions to be 

included in the filtered view. 

Click on the Reset button to reset the data to the default values. 



Payment Eligibility List: Sort Screen 
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This screen allows the user to sort the designated columns on the Student List Payment: View 

screen by something other than the defaulted view of sorting by last name.  

For example, the user may select to sort by Enrollment Status. To do so, highlight the column title 

in the Unselected list of options and click on the arrow pointing                       to the right. 

This will add it to the Selected columns.  Then, use the up arrow to move Enrollment Status to 

the top of the Selected columns. Click on the View tab and you will see a list sorted by 

Enrollment Status.  If the checkboxes next to the Selected columns are checked, the list will be 

sorted in descending order.  If the boxes are left unchecked, the list will sort in ascending order.  

To remove a column from the Selected sort list, highlight the column title and then click on the 

arrow pointing to the left to move it to the Unselected list.    

To move all Unselected columns to the Selected list, click on 

To clear the entire Selected list, click on   



Payment Eligibility List: Columns Screen 
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This screen allows you to select which columns will be displayed on the Student List Payment: 

View screen, and the order in which they will appear. 

To add columns to the Selected list, highlight the column title in the Unselected list and click the 

right arrow to send it to the Selected list. To remove a column from the Selected list, highlight it 

and click the left arrow to move it to the Unselected list.  

If you want to re-arrange the columns once they are selected, highlight the desired column and 

move it by clicking on the up or down arrows until it is in the desired location in the list.  

When you click on the View tab, the columns will display in the order in which they appear in 

the Selected list.  

To move all Unselected columns to the Selected list, click on  

To clear the entire Selected list, click on



Student Detail: Payment Screen

Individual Payment Requests

The Student Detail: Payment screen is a multi-purpose screen that allows schools to view 

payment information or to create or make adjustments to payment requests for an individual 

student record. This screen is accessed by clicking on the dollar sign icon that is on the same line 

as the student’s last name on the Student List Payment: View screen and by selecting the 

Payment tab from the Student Detail: Eligibility screen. 

In addition to the Payment tab, the Student Detail: Payment screen contains the following 

navigation tabs: 

• List – to return to the Student List Payment: View screen

• Eligibility -- to navigate to the Student Detail: Eligibility screen

To navigate to another student, enter the student’s SSN in the Current SSN field and click on the 

Go button. 
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Student Detail: Payment Screen

When requesting payment from the Student Detail screen, there are three required fields: 

• Request 

• Enrollment Status 

• Requested Amount (To adjust the system-calculated annual award amount if necessary) 

‒ The maximum award amount per regular school year is $5,000. 

‒ Any adjustments to the academic level during an award year can potentially 

change the term award. Example: sophomore to junior level. 

‒ The Golden Apple Foundation certifies recipients eligibility one term at time. 

Only the term(s) that have been certified will be available for payment.

‒ Because the Golden Apple Foundation completes certification for Golden Apple 

recipients, any adjustment to a student’s academic level during the award year 

that would impact a student’s award amount must be reported to the Golden 

Apple Foundation so that they can update the student’s certification record. Once 

the certification record has been updated, the school will be able to submit a 

payment request for the updated award amount. The contact person at the 

Foundation is Cheryl Flores at flores@goldenapple.org. 

Each of these fields must be completed with the appropriate information for payment requests to be 

processed properly. If the student is ineligible an Ineligible Reason must be selected and a and a zero 

($0) should be entered in the Requested Amount field. 

Click on the Save Changes button to save the payment request, or the Discard Changes button to 

discard the payment request. 

As a reminder, the payment request process is not complete until the next step of submitting the 

payment requests to ISAC has been completed using the Submit Payment Requests screen.

To navigate to another student, enter the student’s SSN in the Current SSN field and click on the 

Go button.
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Student Detail: Payment Screen
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GA Ineligible Reason

Select the appropriate reason that 

makes student ineligible. 

Not enrolled *

Not a US citizen/eligible non-citizen

Not an Illinois resident

Not a HS grad/no GED

Defaulted student loan

Conflicting scholarship

Not making satisfactory academic 

progress

Reached max number of years allowed

Not a minority

GPA not at least 2.5 on 4.0 scale (soph

or above)

Not enrolled at least half-time *

Student is not accepting MTI

Not enrolled in a teacher program

Not registered with Selective Service 

* If an Ineligible request is submitted, all payment for the 

term will be canceled, unless it is for the reason “Not 

enrolled” or “Not enrolled at least half time” in Semester 1 

or Quarter 1 or 2.



Payment Request Entry

Batch Payment Request

When creating benefit requests for a large number of students, the best option is to do a batch 

request, which is done by selecting students from the Student Payment List: View screen.
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The first step on the Payment Request Entry screen is to select the appropriate academic term 

using the drop-down box in the Term field (initially blank) for which you will be creating payment 

requests. 

A list of your selected records will not display until you have selected a term. 

Once a term has been selected, the list of students you selected on the Student Payment List View 

for that term will be provided, and you can then begin to enter payment information.



Payment Request Entry

To complete the payment request for each student, enter the required data into the appropriate 

fields: 

• Request – Select the appropriate item from the drop-down menu options: 

– “Payment” to create a payment request 

– “Delete” to delete a request that has been created but not yet submitted 

– “Ineligible” to make a student ineligible

– “Cancel” to cancel a previously requested award

• Enrollment Status – Enter full time or half time status

• Ineligible Reason- If the student is ineligible an Ineligible Reason must be selected and a 

zero ($0) should be entered in the Requested Amount field.

– Note: If an Ineligible request is submitted, all payment for the term will be canceled, 

unless it is for the reason “Not enrolled” or “Not enrolled at least half time” in 

Semester 1 or Quarter 1 or 2.

Click the Save button to save your data before navigating to a new page.

As a reminder, the payment request process is not complete until the next step of submitting the 

payment requests to ISAC has been completed using the Submit Payment Requests screen.
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Submit Payment Requests Process

The Submit Payment Requests screen allows the user to submit payment requests to ISAC for 

processing. The user can specify which payment request records will be submitted based on 

Term selected.  

This screen is accessed by selecting the Submit Payment Requests tab.  After payment requests 

have been submitted by clicking on the Submit button a message will be displayed indicating 

how many payment requests were submitted. 

To submit payment requests to ISAC for GA payment follow these steps:  

– Choose the Term for which the request is being made from the drop-down menu. 

– Click on the Submit button to submit the payment request. 

– Ensure that a submission message is received and make note of the number of 

records submitted. 
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Payment Reports

All payment results, for processing done through the GA system, can be obtained at various 

stages in the payment request process through system-generated reports. To create a 

report, navigate to the Reports tab, and then click on the Create New Report
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The Select Report drop down menu is displayed below.  To select a report, highlight the title and 

click on the Request Report button.  Data range fields will then be provided to allow you to 

enter start and end dates for the report.  The date fields are optional fields, and if left blank, the 

report will be cumulative. 



Payment Reports

After requesting a report, you will be returned to the Reports screen where a list of reports that 

have been or are being generated for your school will be provided.   

While the report is processing, the status will indicate In Queue. The refresh button completes the 

report.  When it is ready, the status will change to Completed. To open the report, click on either 

the Microsoft Word or the Microsoft Excel icon.  Additional information about the report, 

including the date, file size and user name of the person who requested the report will also be 

listed.  

Reports displaying the pdf icon         are ISAC-generated reports and identifiable by the user name 

GAInvoice in the last column of the report list. Typically, this report is made available on the next 

business day after your school’s payment request has been processed and will remain available if 

space allows.  It is suggested that you save requested and the Payment Results/Exceptions report 

to your systems for future reference. 

April 2021
26



Payment Results Summary/Invoice Detail

A Payment Results Summary and Invoice Detail Report is generated by ISAC after your school’s 

payment request has been processed. It will include a Payment Results Report and a Payment 

Exceptions Report, as well as Invoice Detail about the payment claim. Typically, the report will 

be provided in the reports section on the next business day after the request has been processed 

by ISAC.  This report is needed to match the voucher/invoice number and payment.   

The Payment Results Summary and Invoice Detail will appear on the report list and can be 

identified by the pdf icon         in the first column and the user name of GAInvoice in the last 

column. 
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The last page of this report provides invoice information, including amount due to the school 

and the invoice number. 

ISAC authorizes a voucher in the amount of the payment invoice and submits it to the State 

Comptroller’s Office which issues payment to the institution.  Vouchers are emailed to the 

Financial Aid Director. The invoice number will be referenced on the voucher authorizing 

payment from the State Comptroller.  Colleges can match the invoice number on the Payment 

Results/Exceptions report with the voucher.  



GA Codes
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Request 

Code Definition

P Payment

C Cancel

I Ineligible

D Delete

Enrollment 

Status Code Definition
H Half-time

F Full-time

Status Code Definition

U Updated

S Submitted

P Payment

Result 

Code

Expanded 

Result Code

Reason

K Ineligible for payment due to due to ISAC Default

F Full GA units already used

4 Request superceded by another request

J Ineligible for payment due to calculated award amount of zero

G Y Full annual award amount already used 

G P Full program award maximum already used 

H Previously paid to your school for requested term

U Cancel requested; no prior payment has been made for this term

Q Y Ineligible reason processed - not eligible for this academic year

Q T Ineligible reason processed - not eligible for this term

R Y Payment reduced to maintain GA annual award amount limit

R P Payment reduced to maintain GA program maximum award 

amount

T With this payment student attains the maximum number of terms. 

Student will no longer be eligible for GA payment

B Payment increased

C Payment decreased

* Payment processed - no reported exception

Y= Annual maximum

P = Program maximum

T = Term maximum


